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Drawings and Specification Preparation Requirements  

Facilities Management is providing this document per the Executive Design Professional 
Agreement (EDPA) Supplemental Requirements paragraphs 1.7.7 and 1.8.3.  This is to aid the 
development of contract drawings and specifications.  The intent is to offer a consistent product 
and reduce risks to project cost, schedule, and errors and omissions.  Please forward questions 
or suggestions to UCI FM Engineering Group Manager.   
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Part A – General: 

1. Documents must be clear, concise, correct, and complete.  Ensure that the construction 
documents are fully coordinated, complete, biddable, and buildable. 

2. UC General Conditions contain important information affecting the preparation of 
Construction Documents.  Reading the General Conditions provides familiarity with contract 
language and terminology thus eliminating common errors found in preparing Construction 
Documents.  Some of the more common items are included in this document. 

3. The term “Contract Documents” means the Drawings, Specifications, and Addendums unless 
modified by Change Order. 

4. Do not refer to “owner,” use “University.”  The term “University” means “The Regents of the 
University of California.” 

5. The term “University's Representative” means the person identified as such in the 
Agreement.  The University must always have a University Representative, who may be a 
University employee, or another entity designated.  Specifications and drawing notes must not 
reference terms such as State, Architect, Project Architect, Campus Architect, Engineer, 
Engineer-in-Charge, Inspector, Client, Project Representative, or Manager.   

6. The Contract Documents are complementary and what is required by one is as binding as if 
required by all.  In the case of conflict between terms of the Contract Documents, the following 
order of precedence applies:  

#1.    The Agreement  
#2.    The Supplementary Conditions 
#3.    The General Conditions (Division 01)  
#4.    The Specifications (Divisions 02-44)  
#5.    The Drawings  

a. In the event of conflicting provisions in the Contract Documents, the specifications will take 
precedence over the drawings unless modified by Addendum. 
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b. Addendums govern over other portions of the Contract Documents to the extent specifically 
noted; subsequent Addendums govern over prior Addendums only to the extent specifically 
noted. 

7. Inappropriate Terms (See additional examples under Part B – Drawings) 
a. Do not use the phrase, “The Contractor shall….” Construction specifications use the 

imperative form of English and the entire package is a set of instructions to the contractor.   
b. Do not use “by others.” Case law has ruled this term ambiguous.  Identify work performed 

by a specific entity.  
c. Do not use phrases with missing objects such as:  as allowed (by whom?), as appropriate 

(according to what?), as approved (by whom?), as directed (by whom?), as indicated 
(where?), or as required (according to what or whom?).   

d. Do not use words such as few and many because they are not quantifiable. 
e. Do not use phrases such as remove as required or install as required. 
f. Do not use prior to bid.  Not every Contractor and sub-contractor is mandated to visit the 

project site before bidding. 
g. Do not use all.  Using all regularly brings into question other contract requirements that 

did not include all. 
8. Only refer to Contractor if it is necessary to delineate who does a specific Work item.   

a. For example, University’s Representative will conduct meetings and the Contractor’s 
superintendent will take notes. 

9. Avoid the use of abbreviations.  When use is unavoidable, use common architectural or 
engineering construction terms and accepted abbreviation symbols.  

10. Do not discuss Contract Documents with bidders during the advertisement and award period.  
Refer bidders to the University’s Representative for a response. 

11. Design Professional must provide a detailed Utility Shut Down Plan, for each utility,  
identifying the utility affected, how the utility is to be isolated, maximum allowable duration 
of interruption (if applicable), and the affected facilities for major shutdowns.  If required to 
minimize disruption to the University’s operations, design professionals must specify by-pass 
or temporary service.  
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Part B – Drawings: 

1. The Drawings are the visual complement of the Specifications. The Specifications describe 
"what" while the Drawings show "how many" and "where." For example, the Specifications 
might describe the type of piping material required, standard to meet, installation 
requirement, etc., while the Drawings show the routing and sizes of the piping, elevation to 
hang piping, and support.  

2. In the event of a discrepancy between the Drawings and the Specifications, the Specifications 
take precedence.  

3. The  design professional must follow these guidelines for preparing the Drawings: 
a. Distinguish between new and existing work.   
b. Everything shown is new unless noted as existing (E). 
c. Use general, or specific, clear, and concise notes to clarify or amplify the Drawings. 
d. Clearly note revisions required. 
e. Clearly delineate alternates, if any. 
f. Show the contract limits on the drawings.  
g. Do not include General Conditions or General Requirements items on the drawings. 
h. Use the same terminology on the Drawings and in the Specifications. 

4. FM project drawings must follow the National CAD Standard except were revised by UCI FM 
CAD standards.  

5. The text must be not less than 3/32-inch high at full size.  
6. Drawing sheet sizes may be 22” x 34”, 24” x 36”, or 36” x 42”.  Select sheet size based on the 

size of the floor plan using minimum ¼” scale plans to show only the scope of work.  You may 
use smaller scales when approved. Avoid using 3/32, 3/16, or other scales not in ⅛-inch 
increments.  

7. Use key plans instead of an overall building plan to scale for the location of Work within a 
building.  

8. Use the UCI FM Master 2021 Title Block sheet with space assigned to the Designated Campus 
Fire Marshal stamp.  Title block data must be consistent from sheet to sheet and trade to trade.   

9. Design professionals must each match floor plan scales within a set and are oriented the same.  
Plan north must be at the top of the sheet unless approved otherwise to match existing drawing 
orientation. 

10. Provide a drawing title sheet for every project set that includes Fire Marshal standard notes, 
existing building construction type, occupancy, building codes, drawing index, and campus 
map with building location noted.  UCI is developing a standard sheet to use (ask if it is available 
when starting a project.)  List deferred submittals – e.g. fire alarm, fire sprinkler piping, fire-
rated partitions penetrations.  Do not use county-level or other larger area maps provide just 
the UCI campus map with the building(s) where the Work will occur noted or highlighted.   

11. Include the UCI project “5 million” number and the applicable UC contract number.  Do not 
include A&E contract number or A&E job number on drawings.  A&E job number may be 
included in an inconspicuous location.  

12. Do not place computer file locations on the drawings. These serve only to confuse people that 
receive them.  

13. Use existing room numbers as observed at the building.  Submit plans when adding new rooms 
to Engineering Group early in the design process so new space can be numbered and used 
throughout the set.  

14. In the event of conflicting provisions within the drawings, the following order of precedence 
for resolution of the conflict applies:  the more specific provision will take precedence over 
the less specific, and figures take precedence over scaled dimensions. 
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15. Rehabilitation Projects 
a. Provide clear graphical delineation of demolition work - existing work to remain and 

construction work.  
b. Identify existing materials as “existing” or “(E)” and show them with light or screened 

lines.  
c. Show new work and new materials without the word “new.”  Work shown and not called 

out as “existing” is “new” work.  If one item is marked “New,” then every new item will also 
have to include “New,” and if you miss one then that could be cause for a change order.  

d. Show new work on drawings with a heavier line weight(s) than existing. 
16. Demolition drawings must use the following definitions taken from Division 01 3516 

“Alteration Project Procedures” specification.  
a. Remove: Detach items from existing construction and dispose of them off-site, unless 

indicated as Remove and Salvage or Remove and Reinstall.  There is no need to say, 
“Contractor shall remove xx…” or say “existing” – just say, “Remove xx…” 

b. Remove and Salvage: Detach items from existing construction, in a manner to prevent 
damage, and deliver to University ready for reuse or Contractor to store. 

c. Remove and Reinstall: Detach items from existing construction, in a manner to prevent 
damage, prepare for reuse, and reinstall where indicated. 

d. Existing to Remain: Leave existing items that are not either “removed,” “removed and 
salvaged,” or “removed and reinstalled”   

e. Demolish: To remove by destroying or ruining the item being careful not to damage items 
“existing to remain.”  The contractor will replace or repair items mistakenly demolished 
or damaged at no additional cost to the University.  

f. Dismantle: To remove by disassembling or detaching an item from a surface, using gentle 
methods and equipment to prevent damage to the item and surfaces, and disposing of the 
items, unless otherwise indicated. 

17. The University prefers that demolition plans be on the same sheet as new work floor plans.  If 
not, locate the demolition sheet right before the new work floor plans sheet and use the last 
digit to separate the plans and without the second sheet number digit include the “D.” For 
example second-floor plans would be: A-121 (demo plan) and A-122 (new work plan) 
a. Note: Very rarely, if ever, does FM have a major demolition project that requires sheet 

numbers with D (e.g. AD121, PD121, MD121, etc.). 
18. Terms used on the Drawings to identify materials and equipment must precisely match terms 

used in the Specifications.  
a. Refer to inappropriate terms in Part A – General above. 

19. Do not shade existing walls or use shading at all. 
20. Drawings must not include consultant and sub-consultant personal contact information such 

as name, phone numbers, or email addresses. Provide Firm name and business address. This 
is part of University Cyber Security best practices to minimize personally identifiable 
information retention. Need-to-know contact lists are usually part of the project process after 
award of contract and need not appear on drawings.  

21. Provide an abbreviations list and description on the Drawings that includes only the ones used. 
22. Carefully check General Notes commonly employed for private work.  Many times these notes 

conflict with the University’s front-end documents or General Conditions. 
23. Do not place specifications on drawings.  UCI projects require book specifications.   
24. Limit the use of color on AutoCAD drawings to representing line weights.  Use conventional 

hatching and other methods such as varying line weights to communicate without the use of 
color. This allows persons with color vision difficulties to make full use of the drawings and 
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helps the University conform to best practices for persons with disabilities. Many more people 
have color acuity difficulties than is commonly realized.  

25. Show general notes once in drawing set on a trade’s general sheet, e.g. M-001. Ensure that 
general notes conform to the University’s requirements. Working for the University is 
considerably different from private construction practice.  

26. Avoid creating sheets with less than 50% of the drawing area used.  UCI’s standard sheet 
numbering allows combining sheets instead of adding a standard sheet number.  

27. Blocks of lettering can be hard to read. Use the available tools in AutoCAD to provide clear, 
legible, correctly spelled, and grammatically correct notes. The use of upper and lower case 
letters greatly improves legibility in blocks of text. Small Caps are another option. Arial All Caps 
is not the equivalent of hand lettering and is more difficult to read.  

28. Describe Work using correct grammar, punctuation, and symbols with simple and succinct 
notes and sentences.  Typically, sentence construction is the imperative form of English.  For 
example, “Install pumps per in accordance with manufacturer’s instructions.” and not “The 
contractor shall install pumps in accordance with manufacturer’s instructions.”  

29. Most FM projects are small and drawings must reflect that.  Do not include notes, symbols, 
abbreviations, details, etc. not applicable to the Scope of Work.  Do not add typical information 
just to cover inapplicable circumstances.   

30. At each submittal, only show notes, details, references, etc. applicable to the Work required.  
Show the Work required with specific project notes.   

31. Do not include quantities unless specifically requested.  Drawings need to show the extent of 
the Work for the bidders to do a takeoff to determine quantities.  

32. Provide symbols with a legend describing the work instead of Key Note numbers with “typical” 
pointing to a symbol.   

33. Place keynotes close to the plans, details, or diagrams using the keynotes. 
34. Key Notes on plans may be used for repeated or multiple items instead of writing numerous 

times.  It is much clearer for the project manager, contractor, inspector, or reviewer if the 
designer writes the notes next to the item once or a few times instead of having to refer to a 
keynote across the sheet or several sheets away. Electronic presentation and review make this 
concept even more important.  

35. Indicate how the existing piping system can be shut off at points of a new connection.  If this 
does not exist, then the project must describe work to allow the system to shut down.  If 
necessary, specify hot-tapping for piping.  Always provide a gate or ball valve at a point of 
connection to existing pressurized piping.   

36. Design electrical work for construction with the electricity shut off.  Review the effect an 
electrical shutdown has on the existing systems and detail when and how this can be done. 

37. FM projects always deal with existing construction.  Make sure drawing details proposed to 
address existing conditions and are not just standard details.  Delineate with line weight new 
work or existing.   

38. Where necessary, modify Campus Standard Details to delineate new work from existing.  
Submit such modifications for review.  

39. Each project submission must include the date of submission on the title block throughout the 
complete drawing set.  

40. Working in existing facilities requires that the design professionals determine the actional 
routing for piping, ductwork, and conduit and clearly show them on the drawings.  Show the 
locations of ducts, pipes, and conduits examples include, above the ceiling, exposed, at 10’-0” 
A.F.F., inside the wall, etc.  

41. Unit prices, Alternates, and Allowances requirements are usually only described in Division 01 
and normally not on the drawings.  This depends on the work descriptions and if specific 
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details are drawn just for an allowance or alternate, then the drawings would reflect the 
requirement.  

42. Before submitting drawings for review, please read EDPA paragraph 4.9. This paragraph 
requires submission of calculations with design criteria, assumptions, and references used.  
Include copies of selected equipment data sheets, e.g. light fixtures, air handling units, heat 
exchangers, plumbing fixtures, and photometric plans.  Design Calculations are different from 
Design and System Narratives at the schematic phase.  

43. Equipment schedules on drawings must include complete specific capacity requirements.   
a. Provide all parameters for coils both thermal and physical. 
b. If there are only a few items, it is fine to place equipment schedules on drawings and not 

use a separate schedule sheet. The sheet numbering system shows how to number the 
sheets properly. It does not dictate that you must have each type of sheet.  

44. Show the existing building’s fire-rated partitions, walls, and shafts that could be penetrated by 
your project’s scope of work and the type of wall construction.  To bid projects, this must be 
shown.  Deferred approval of penetrations is acceptable and not necessary to show fire-rated 
penetration details on the plans.   

45. Confirm University furnished record drawings by field verification and checking sizes, 
especially for new connections to existing systems. Show existing sizes for plumbing, 
mechanical, and electrical work on drawings. 

46. UCI Standard Details will be furnished in AutoCAD (*.dwg) format and must be included on the 
drawings with the UCI Standard Detail title block, and detail number. If modifying the detail for 
the project, submit the proposed modification to the University’s Representative for review 
and approval before using the detail on the drawing. Else, use University Standard Details 
without modification.  

47. Provide coordinate structural grid on floor plans from existing original construction drawing.  
If none exists or the design has a new structure grid, use numbers on the long axis and letters 
on the other.  The purpose of this is to allow quick reference to a point on the drawing sheet. 

48. Create, or update, riser diagrams for any modifications to supply, exhaust, drainage, 
compressed air, water, natural gas, or heating systems. This is required for lab ventilation 
safety and useful for all cases especially Central Plant utilities – High Temperature Water, 
Chilled Water, Electrical power, Compressed Air, and Natural Gas.  Provide calculations to show 
the connection to existing systems will not overload the existing system.  

49. Create section and elevation drawings where ducts cross and at least two sections for new 
major mechanical equipment installations and where plumbing piping or electrical or any 
other existing construction to show the contractor the extent and difficulty of the installation.   

50. Using black and white photos on drawings to show existing conditions and new work has 
proven to be of value in many projects.  

51. Avoid the use of subjective and arbitrary notes, such as those in the following examples: 
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Examples of Inappropriate Written Notes 
 

Example No. 1: 
“The General Contractor shall be responsible for coordinating the work of all trades and 
subcontractors.” 

(There are no General Contractors, only Construction Contractors.  Contractors are required 
to coordinate work amongst themselves as described in the General Conditions.)  Note should 
read: 

Coordinate work with other trades and contractors. 

Example No. 2: 
 “Repair wall opening to match existing wall. Caulk and seal with a sealant of high quality 

and long life to prevent infiltration of outside air and water mechanical room.” 

(High quality and long life need to be defined.) 

Repair wall opening with [state material to use] and provide with 
waterproofing sealant to prevent infiltration of outside air and water into 
mechanical room. 

Example No. 3: 

 “All construction shall conform to the latest edition of all building codes and ordinances. 
The Fire Prevention and Building Code, the ADA code, and in case of conflict the most 
stringent shall govern.”  

(Consultant is responsible to include scope complying to codes.  Such a note is not needed as 
this is covered in General Conditions and title sheets showing listed codes.) 

Example No. 4: 

 “Piping penetrating firewalls shall be fire stopped with a 3M or equal system for through 
penetrations approved for the specific application.” 

(Consultant needs to show locations and ratings of walls, partitions, and barriers.) 

Example No. 5: 

 “It shall be the responsibility of the Contractor, prior to submitting a bid, to visit the site 
and inspect the entire area of the work. The Contractor shall be completely familiar with 
all existing conditions affecting the work. If in the execution of the work, extra work is 
necessary due to the Contractor’s failure to be familiar with existing conditions such extra 
work shall be furnished and installed by the Contractor at no additional cost to the owner.”  

(Every bidding Contractor is usually not required to visit to project site. The consultant must 
show the work required and the existing conditions.  Note can state:) 

Prior to construction, confirm that existing conditions match the drawings.  Bring 
any inconsistencies to the University Representative’s attention for resolution.  
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Examples of Inappropriate Written Notes 
 

Example No. 6: 

 “Include the cost of all small details and incidental work not shown or specified but which 
is required for a complete and satisfactory system.” 

(All work needs to be indicated in the documents.) 

Example No. 7: 

“Lighting levels shall be per IES Standards (35 foot candles average and 20 foot candles 
minimum) Contractor shall install/remove lighting fixtures based on actual field lighting 
level measurements.” 

(Scope of work needs to be clearly indicated and is note is not biddable.) 

Example No. 8: 

Do not include subjective phrases such as:  

 Provide trap and vent “as required” 

 Provide condensate pumps “if necessary” 

 Provide fire dampers “as needed” at all rated wall penetrations  

 Install all work “in an approved manner”  

(The Inspectors struggle with the final acceptance of components shown to be installed “in 
an approved manner.” Referencing specific standards can often mitigate disputes that 
arise from subjective comments.) 
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Part C – Specifications: 
1. Use the UCI FM Master Specifications, which follow the CSI standard for Specifications.  Edit 

UCI Master Specifications to suit the project’s specific Scope of Work.   
2. Every UCI project will have book specifications.  Do not place specifications on drawings.   
3. If a UCI FM Master Specifications section is not available for a specific product, ask if FM can 

provide one.  If none is available, then A&E must write the 3-part CSI specification using FM’s 
standard font and format to match FM master spec sections.  

4. In the event of conflicting provisions within the specifications, the following order of 
precedence for resolution of the conflict applies:  the more specific provision will take 
precedence over the less specific; if not resolved, the less stringent will take precedence over 
the more stringent; if not resolved, the less expensive item will take precedence over the more 
expensive. 

5. Master specs are written keeping words or numbers together on a single line for easier reading 
by using a hard space.  To insert a hard space, press at same time: [Ctrl] + [Shift] + [Spacebar] 
keys.  Examples include Division 01, Section 05 2525, ASTM C129, or AMCA 987.   
a. Note: if showing formatting symbols, Microsoft Word shows a hard space symbol like a 

degree symbol.  They are different and can be confusing.  Turning off formatting symbols 
clears that issue.  

6. UCI FM master specifications use the degree symbol “°”and not “deg F.” or other abbreviation.  
Use the degree symbol for consistency “°F”– one way to insert degree symbol: ALT+248 
another is ALT+0176. 

7. When fractions are used, enter with ALT codes.  For example, use ⅛, not 1/8 or ⅜ instead of 
3/8 or 1⅓ as a replacement for 1-1/3.  Below are common vulgar fraction ALT codes. You may 
need to use a number keypad: 

Char Alt code Char Alt code Char Alt code Char Alt code 
⅛ ALT+8539 ¼ ALT+0188 ⅕ ALT+8533 ⅙ ALT+8537 
⅜ ALT+8540 ½ ALT+0189 ⅖ ALT+8534 ⅓ ALT+8531 
⅝ ALT+8541 ¾ ALT+0190 ⅗ ALT+8535 ⅔ ALT+8532 
⅞ ALT+8542   ⅘ ALT+8536 ⅚ ALT+8538 

8. UCI Contracts department will insert the final header for the project.  Revise the header with 
minimum verbiage to show the project name or number only.  You may add a date.    

9. Confirm specification references to other sections you have are included in the specification 
manual.  To identify those references, quickly, use the search command for section and 
division. 
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Part D - How to Edit UCI Master Specifications  

1. The design professional must write the technical specifications for the project, CSI Divisions 02 
through 33, using Facilities Management’s master specifications.  Edit the materials, products, 
and equipment and any modifications of the installation procedures to form the basis of the 
bid proposal.  Make changes and additions to the specifications with the Microsoft Word “Track 
Changes” feature to show additions in “Bold” and deletions with crossed-out text.  Any changes 
made without this type of indication to the University’s reviewers are prohibited.  The 
University will furnish the Word files as a protected document that will automatically track 
editing to allow a quicker review by the University and confirm Campus Standards are 
maintained.   

2. Facilities Management’s master specifications contain requirements describing functional 
requirements for the project, and describing materials, products, and systems for the project, 
and criteria for verifying compliance.  References quoted in Campus master specifications must 
be understood to be the published and dated version of the reference in effect as of the Contract 
Bid Date.  Do not reuse master specifications from project to project.  Obtain the latest Master 
Specification from the University’s Representative.  Correct egregious errors as needed.   

3. The design professional is responsible for preparing the final edited specifications coordinated 
with the drawings in compliance with the Scope of Work.  FM master specifications establish 
the minimum requirements acceptable to the University.  We will not accept edits that reduce 
quality, materials, or workmanship.  Provide with the specifications a table of contents showing 
all divisions and sections included. 

4. The following is a basic “how-to” edit the Section Text: 
a. Begin with Part 3 - Execution.  Edit the Article to retain applicable Schedules and 

Execution to the Project.  Proceed with the following: 
b. Delete services, locations, sizes, and other options not required. 
c. Review the installation articles.  Delete requirements corresponding with services 

deleted in the step described above. 
d. Edit Part 2 - Products.  Review and delete materials as follows: 
e. Delete pipe and fitting materials to correspond with those that you deleted from Part 3 

"Piping Schedule" Article.  Add material options required but not listed; delete listed 
options not required. 

f. Delete joining materials that correspond to the pipe and fitting combinations deleted in 
Part 3 "Piping Schedule" Article.  Add material options required but not listed. 

g. Edit Part 1 - General.  Review and delete requirements as follows: 
h. Revise the "Summary" Article to correspond with Part 2 materials and products still 

included and Part 3 "Piping Schedule" Article. 
i. Delete requirements in the "Submittals" and "Quality Assurance" articles that correspond 

to product and execution requirements deleted from Parts 2 and 3. 
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The master specifications include editor’s notes as blue hidden text.  In Microsoft Word 2007 
through 2016 click the “Office Button” in the upper left corner or “File” tab, click “Word Options,” 
and then click “Display.”  Under “Always show these formatting marks on the screen” make sure 
the “hidden text” check box has a check within it.  See screen view below: 

 

 

To show the hidden text in Word 2003, go to the 
“Tools” menu and select “Options” (see insert 
right).  Select the “View” tab to show the hidden 
text.  The check box should show an X in the box 
for the “hidden text” option.  To print the hidden 
text, select the “Print” tab on the “Options” 
screen and place an X in the check box next to 
“hidden text.”  Make sure to turn this off when 
you print the final copy.   
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Not every type of material or product for your project may have a specification section.  Add 
sections as needed for the work and design features that the Design professional has selected.  
For any new sections, contact the University’s Project Manager or Engineering Group to 
determine if a master specification is available.  Placing product specifications on the drawings 
is prohibited.  

MasterSpec by Deltek Avitru (Formally Arcom) is the basis of Facilities Management’s Master 
Specification sections.  You may use the Masterworks macros to edit the documents if your firm has 
purchased the system.  Our license agreement allows editing by consultants.  

Do not change the specification footers, section numbers, or titles.  Do not delete or change the 
style features.  This will retain the automatic paragraph numbering and formatting of the 
document.   

The FM Master Specifications will be locked and will remain locked to track all changes made.   

When editing new sections or if not locked, set the Microsoft Word 2007 “Track Changes” feature 
as shown below.  On the Review tab, select the “Track Changes” drop-down menu, then click on 
the “Track Changes Option.”  In later Word editions go to the Review tab, tracking section, and 
click on the 45° right down arrow to get the Track Change Options and then select Advanced 
Options.  

When editing these sections, set the Microsoft Word “Advanced Track Changes Options” or 
“Track Changes” feature as shown below.  Under the Tools menu, select “Options,” then click on 
the “Track Changes” tab.  Edit the options for formatting as follows: 
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When printing specifications during project development, use the “All Markup” or “Final 
Showing Markup” setting in Word, which will show Track Changes., The Contracts Department 
will print with this setting at “No Markup” or “Final.”   

Where the text in the document is bracketed and usually bold, this indicates an option for selection 
by the editor.  Delete the options not required, delete the brackets, and remove the bold formatting 
of the text that remains. 

Edit the options for formatting as follows:  <Text> requires insertion of data 

[text] requires decision to delete, retain, or edit text in brackets 

For example, [Text1] [Text2] [Text3] could be edited to become [Text1] [Text2] [Text3] (with the 
“Display for Review” set to “Final Showing Markup.” 

Do not use the “strikeout” mode in Fonts to delete text.  Use cut, delete, or backspace to delete text. 
The “track changes” function shows deleted text in strikeout format. 

The Article and Paragraph numbers should renumber automatically when you delete an Article or 
Paragraph.  If this does not happen, then you may leave the numbering and add “Omitted” for the 
complete text. 

Use the “Increase Indent” and “Decrease Indent” on the Word 2007 “Home” tab and Word 2003 
“Formatting” toolbar to revise paragraph subordinate level. 

The following are the styles used in some of the University’s master specification sections:  

Style Name  Description  

ART   
The style used for the Article titles is Bold. Number style is with 
the first number being the Part number followed by a period and 
a two-digit number. Example: 1.01.  

CMT  An editor’s Note to the A&E that can provide direction and help when 
editing the specification and is in blue hidden text  

PR1 = Level 1  Paragraph level 1 follows Article titles. Number style is an 
uppercase letter. Example: A.  

PR2 = Level 2  Subparagraph level 2 follows a paragraph level 1 and is a number 
followed by a period. Example: 1.  

PR3 = Level 3  Subparagraph level 3 follows a Subparagraph level 2 and is a 
lowercase letter followed by a period. Example: a.  

PR4 = Level 4  Subparagraph level 4 follows a subparagraph level 3 and is a 
number followed by a parenthesis. Example: 1)  
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Style Name  Description  

PR5 = Level 5  Subparagraph level 5 follows a subparagraph level 4 and is a lower 
case letter followed by a parenthesis Example: a)  

For those alternates accepted by the University, the design professional must coordinate any 
materials defined as part of the alternate and provide modified or new specification section(s) for 
those items not identified in the master specification sections.   

For each design submittal, consolidate specifications by the 2004 CSI format.  Upon acceptance of 
Specifications by the University’s Representative, all materials, equipment, fixtures, devices, and 
systems, which are provided and installed in the Project, must be as described in the Specifications 
manual, which has been submitted by the design professional and accepted by the University’s 
Representative.   

Final printing:  The University will do the final printing after a review of the specifications' electronic 
files.  The University may make format changes and correct obvious errors.  

The University furnishes the Division 01 specifications as pdfs FOR REFERENCE ONLY.  Unless 
approved by the University’s Representative, do not modify them.  Submit any changes to the 
University’s Representative for review.  The project manager may ask you for a written Scope of 
Work for section 01 1000 section.  
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